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1.  Getting Started
Welcome to Visual Home! Here are the best ways to understand how this program works.

The Guided Tour
The Guided Tour is a series of audio and video segments that take you through the basics of Visual Home. 
We recommend that first-time users take the Guided Tour. The Guided Tour plays automatically the 
first time you run Visual Home after you install it.
To start the Guided Tour, go to the entry screen if you aren't already there by selecting File/New. Then click 
the Guided Tour button to begin. You can also join the Tour from other places in the product by clicking on 
the Guided Tour buttons. The buttons play only those parts of the Tour relevant to where you are in the 
program.

Sample Files
Visual Home provides a number of home designs and furnished rooms that you can study and modify. To 
look through the Sample Files, select them from the entry screen. Or select "Open Sample" from the File 
Menu. See Sample Files.

Sample Files
Visual Home provides a number of designs for you to modify or to give you new ideas for your own plans. To 
look through the Sample Files, select them from the entry screen. Or select "Open Sample" from the File 
Menu. Choose a file by highlighting the name on the left side and click OK. You will see your selection 
appear in Step 4 of the QuickDesign™ Wizard
Many of our sample floor plans are based upon designs from HomeStyles, Inc. They provide building plans 
for a fraction of the cost of an architect. If you like a plan you see here, please call them at 1 800 547-5570. 
Mention the plan number you'll see below each description.

Create your own sample from scratch and save it by selecting the "Save as Sample" command under the 
File Menu. It will also appear under the "My Samples" tab. To delete your sample files from the list, refer to 
the Visual Home ReadMe.txt for instructions.

Want to Publish Your Own Design?



Books That Work would like to publish your sample files on our website and in future releases of Visual 
Home. We're looking for everything from whole houses to single, furnished rooms. We will review all designs 
submitted and choose those best suited for publication.
In your file, record a WalkAbout™ and save some snapshots so others can view the design as you intend. 
Also submit a short explanation of the merit of your design and a title of your choice.

To submit your sample file, choose one of two methods:
1. Save your design on a floppy disk and mail it to us at the address below.(Remember to put a piece of 
cardboard in the envelope to protect the floppy).

Books That Work
ATTN: Visual Home
2595 E. Bayshore Rd.
Palo Alto, CA 94303

2. If you are familiar with FTP, you can transmit the design via the Internet. Connect to the host "btw.com", 
log in as "vhsample", and use the password "vh06b01".  Don't forget to use the "binary mode" for file 
transfer.

We will credit you by name unless you tell us not to. If you submit a sample file for consideration, please 
understand that you are giving us unrestricted rights to modify and publish the file.

2.  QuickDesign™ Wizard: Building with RoomBlocks™
Use the QuickDesign™ Wizard whenever you start a new home design. We recommend that you build all of 
your rooms with the QuickDesign™ Wizard, even if you are only working with one room.
With the Wizard you can quickly select and layout RoomBlocks™ to form the structure of your design. Then
add doors and windows, step by step. Once you're satisfied with the general layout and window and door 
placement, click Build Now and you will see your home design in Top View and 3D View.
The Wizard helps you think first about the basic structure of your design before you add furnishings and 
room styles. For example, how many rooms do you want in your home? What rooms should connect to the 
entry? How far from the kitchen will you place the bedrooms?
RoomBlocks™ automatically generate walls, floors and ceilings. When you move these RoomBlocks™ they
carry these components with them -- even retaining their furnishings and styles. 
Note that it is a lot easier to create RoomBlocks™ with the Wizard, than with the Object Tool Bar in Top 
View. While the Wizard automatically builds your room's floors, walls and ceilings, you will have to add your 
own walls if you create a room in Top View. 
For additional help in the Wizard, choose a topic below.

Choosing Rooms
Arrange Rooms
Place Doors
Place Windows
Saving as a Sample 
Before You Build

Choosing Rooms in the QuickDesign™ Wizard
In Step 1, select the RoomBlocks™ you want to include in your design by clicking on the checkbox next to 
each room name. If you change your mind, you can add or delete rooms in Step 2, or in Top View.
Indicate the number of bathrooms and bedrooms you want by clicking on the up/down arrows. You will 
automatically get a closet for each bedroom.



The right-hand side of the screen allows you to add more rooms, and to make your own room names. For 
example, suppose you want to include two dens in your house. To do this, click on the down arrow to view a 
drop down menu of room types. Highlight "den" so that it appears in the field. Notice that the word den also 
appears in the field to the right. This field allows you to type in another name of your own. You can call it an 
"office," or "Mary's den," or any name of your choice.

Arranging Rooms in the QuickDesign™ Wizard
The rooms you selected in Step 1 now appear on the screen in Step 2. Here, you can arrange the rooms any
way you like. To move a room, click and hold anywhere in the center of the room, and drag it to a new 
location. Notice that rooms "snap" to each other as they get closer. This is to ensure that rooms line up 
evenly. To resize a room, drag its handles. 
To add another room, click "Add Room" and select one from the list. To delete a room, simply select it with 
your mouse and click the "Delete Room" button or the delete key.
To change the shape of a room, select it and click "Change Shape." Click on one of the choices, click OK, 
and the new shape will replace your old room. Note: the new shape requires sufficient space to fit between 
the adjacent rooms. If there isn't enough room for the new one, drag the old room to one side and try again.
To build a second story, create its floor plan next to your first floor. While Visual Home will not build the 
second story on top of the first story in the Designer, it will build them next to each other so you can work on 
both stories within the same file.
Notice that there is a vertical and a horizontal ruler to provide you with dimensions for each room. You have 
the option to view your rooms' dimensions in English or metric units. See Dimensions in Visual Home.

Placing Doors in the QuickDesign™ Wizard
Use Step 3 to think about where you want doors in your home. Few decisions affect circulation so much as 
where you place the doors. Think of these doors as placeholders for now. Once you complete the Wizard 
and enter Top View, you can re-size, move, delete, or add new doors, as well as edit colors, materials and 
styles. To add a door, click once on a door at the top of the screen and then click on the spot where you want
to place it in your design.

Placing Windows in the QuickDesign™ Wizard
Use Step 4 to make initial decisions about the location, number and style of windows in your design. Think of
these windows as placeholders at this stage. Once you complete the Wizard and enter Top View, you can re-
size, move, delete, or add new windows, as well as change their materials. To add a window, click once on a
window at the top of the screen and then click on the spot where you want to place it in your design.
This is the last step in the QuickDesign™ Wizard. It's much easier to create rooms here than in Top View. 
While the Wizard automatically builds your rooms' floors, walls and ceilings, you will have to add your own 
walls if you create a room in Top View. 

Save as a Sample
If you want to retain a copy of your QuickDesign™ layout, save it by selecting "Save as Sample" from the 
File Menu. Your design will be saved as a sample which is later accessible under Sample Files. While using 
this command will not save furnishings and styles that you add later in Top View, it will create a template that
you can use again and again.

Before You Build
Once you start to make changes to your design in Top View, you cannot go back to the 
QuickDesign™ Wizard without losing your Top View changes. 
Also, since the Wizard creates RoomBlocks™, any room that you add in the Wizard automatically includes 
its walls, ceiling and floor. If you add or create a room in the Designer, however, you only get the ceiling and 
the floor of the room. You have to add walls to the room separately to make it a complete RoomBlock™.



Consequently, it is harder to move and resize rooms neatly in Top View than it is in the Wizard. The 
automatic creation of complete RoomBlocks™ in the Wizard also makes adding rooms easier here than in 
the Designer.
Tip: It's always better to add more rooms than less. If you want to get rid of a room later, simply delete it in 
Top View. 

Saving Your Sample
If you think you might return to this template, save it by selecting "Save as Sample" from the File Menu. This 
saves your plan in the QuickDesign™ Wizard. This command will not save furnishings and styles that you 
add later in Top View, rather it will create templates that you can use again and again.

3.  The Designer: Refining Your Plan
After laying out your design using the QuickDesign™ Wizard, Visual Home takes you to the Designer, the 
main part of the program, where you will do most of your work. Notice that the screen is split up into two 
views: Top View and 3D View. Top View is where you can add objects and apply styles. In Top View, you 
can drop objects from above, arrange and edit them.
3D View shows you a realistic representation of your design. The red camera seen in Top View controls 
what you see in 3D. You can also move through your home, using your mouse or the arrow keys at the top of
the screen. 
Notice that you can switch between Top and 3D views just by clicking each window to make it active. When a
View is active, its corresponding tool bar shows at the top of the screen. 

Top View
3D View
Using the Camera
Shopping List 

Top View
You will add most of the objects to your home in Top View. When you first place objects in your design, 
Visual Home automatically sets them to default dimensions, colors, textures and other specifications. Use 
these, or choose your own styles for your objects, using the Spec Sheets. You can also set the look of your 
entire room with Room Spec Sheets.
To save time and get more consistent results, copy your customized objects. See Adding, Resizing, and 
Positioning Objects . 
Once you have decorated a RoomBlock™, you can move the entire unit, along with its furnishings, from one
place to another by dragging the room. 
When you have finished your design, use the camera to position your 3D viewing angle(See Using the 
Camera). Then click on the 3D View window to make it active and see your home in 3D. 

3D View 
3D View is where you get to WalkAbout™ a realistic representation of your design. To enhance your 3D 
scene, re-arrange furniture using the "Edit Stuff" command, adjust your camera angles, set the lights and 
rendering quality, and record WalkAbouts™ and snapshots to keep track of your work or to showcase them 
to others.
Notice that you can switch between Top and 3D views just by clicking either window to make it active. When 
a View is active, its corresponding tool bar shows at the top of the screen. 

3D View Navigation 
Recording a WalkAbout™ 
3D View Scene Options 



3D View Navigation
There are three ways to navigate in 3D View.
Dragging the mouse inside the 3D View window
Using the keyboard arrow keys
Clicking the tool bar arrow keys

Dragging the Mouse
Your 3D View is divided into 4 sections: left, right, top and bottom (refer to the graphics below). Direction is 
controlled by the section in which you move your mouse.

 
Always start with the cursor in the center of the 3D window.  Dragging the mouse to the right side area 
of your 3D window rotates your view to the right. Similarly, dragging your mouse to the left area of your 
screen rotates your view to the left, dragging it in the top moves you forward and 'into' the image, and 
dragging it in the bottom half moves you further back.
Your speed is controlled by how far from the center of the window you are. The closer your mouse is to the 
center of the window, the slower your movement. On the other hand, dragging the mouse away from the 
center increases your speed.
Confirm that the WalkAbout™ button is highlighted in the top tool bar and that the Mouse is set to "Move 
Me" instead of "Edit Stuff." (Both of these should already be set by default when you first switch to 3D View).
Notice that at the bottom of the 3D View screen, there are additional instructions concerning the mouse.  
Adding the Shift key while dragging the mouse moves you sideways while adding the <Ctrl> key will change 
the height of your view.

Using the Keyboard Arrow Keys
The keyboard arrow keys move you in small, precise steps in any of the four directions. The keyboard arrow 
keys can be used only in WalkAbout™ mode.
3D Navigation Tool Bar
3D View tool bar

Click the Move arrows to move in the direction that you want. To adjust your viewing height, click on the up 
and down arrows. The viewing height appears in the window next to the up/down arrows. Click the View 
buttons to view your design from above or at eye level. Use Tilt to control your viewing angle. Use the Zoom 
In/Out button in the Design Tool Bar to change the magnification of objects.

Recording a WalkAbout™
Visual Home saves your favorite views and tours for each file in the Recorder. This allows you to quickly 
return or show others what you want them to see.
To access the Recorder, click the Record button on the Side tool bar, or select it from the Features Menu.

Taking Snapshots
Snapshots are a great way to store a list of sites in your design you wish to return to or show others. 



To take a snapshot of a 3D View scene, click the "Snapshots" tab. Type in the name for your snapshot in the
field or simply click "Record" and a generic name automatically appears. Click "Record" and the snapshot is 
stored. Click "Play" to view a snapshot selected from the list.

Recording a WalkAbout™
 First position the red camera in Top View where you want to begin your WalkAbout™. You can further 
adjust your initial view by switching to 3D View and using the arrow buttons in the 3D navigation bar. 

 Type in a name of your own into the field. Or leave it blank and the Recorder will automatically assign your 
WalkAbout™ a generic name.

 Click "Record" to begin recording. Once you click "Record," notice that the button becomes briefly 
highlighted to let you know that you have activated it. 
Tip: Notice that while the Recorder is running, the Stop button becomes available. This is a good way to tell if
you are still running the Recorder.

 Now navigate through your 3D scene and the Recorder will store all of your movements as well as the 
speed of your movements until you click the "Stop" button. 
After you click Stop, your WalkAbout™ gets stored and will be available every time you open your saved file. 
You can delete a WalkAbout™ at any time by selecting it from the list and clicking "Delete."

Playing a WalkAbout™
To playback a WalkAbout™, select it from the list and click "Play." Notice that the "Play" button becomes 
briefly highlighted to let you know that the playback is running. While a WalkAbout™ is playing, click on 
"Pause" to pause the playback (the "Pause" button toggles with "Resume.") Click "Resume" to continue the 
playback. 
Tip: Notice that the Play/Resume button only becomes available during a playback and not during a 
recording.

3D View Scene Options
Set Lights
Use arrows to adjust the lighting in your 3D scene. This is useful for seeing details or colors more realistically
in your design.

Choose Quality of Scene
Select (1) Full Light, No Materials, (2) Minimal Light, All Materials, or (3) Full Light, All Materials to determine 
the rendering quality of your 3D View. Lower light and number of materials increases drawing speed. 
Likewise, using full light and all materials improve the quality of rendering, but slow your machine's 
performance speed.
You can also set your scene quality by selecting "Cartoon Color Mode" from the Options menu which is the 
equivalent of Full Light and No Materials.

Using the Camera
The camera tool is your window to 3D View. Adjust the camera (shown in red in Top View) so that it points 
towards an area that you wish to see in 3D View. As long as the camera is in this position, any changes that 
you continue to make to this area, automatically appear in 3D View. 
To move the camera, select it so that the word "Move" appears above the cursor. Then drag the camera to a
place in front of the area that you want to see in 3D View. Notice that the 3D View window adjusts 
immediately as you move the camera. You can also rotate the camera after it is selected, by dragging its 
spin handle. 

Shopping List 



Use the Shopping List to get a rough idea of how much your design might cost to build from scratch. It will 
also help you keep track of selected objects, as well as their quantities, installed prices, unit prices, and 
subtotals. 
To access the Shopping List, either select "View Shopping List" under the Features Menu or click on the icon
in the Side Tool Bar if it's visible on your screen.
Each major category is shown as a button on the left side of the list. Click the button to see a breakdown. 
Click the button again to hide the details. 
To add notes to yourself, type them in the field on the right side.

The Shell price
This item represents typical costs, including labor to build the basic structure, including foundations, floors, 
walls and roof, plus the electrical, plumbing, heating and cooling systems in a typical home. It is strictly based
on the square footage of floor area you've drawn. Double-click "Shell Price" to edit the per square foot cost. 
To edit the shell cost, select a Price Range. A Bargain Home represents the lower end of the price range 
while a Custom House represents the high end. You can also enter your own price in the appropriate box.
The price is then multiplied by the total floor area of your house (shown on the left side), to give you your 
total shell cost on the right side of the dialog box.

Adding Objects to the List
Most architectural elements you add to your design are automatically placed on the list. By default, you will 
see all of these items. If you select "Show All On the Shopping List" under the Options menu, furnishings that
have prices also appear.

Modifying Prices
While you are in the Shopping List, you can access any of the Spec Sheets for the objects listed there. 
Simply double-click on a line to bring up that object's Spec Sheet. Here, you can make changes to your 
object, including its current price. (See Using Spec Sheets for more info).

Adjusting Field Lengths
To increase the width of any field, hold the cursor at the end of the field until the cursor changes to look like 
this: . When you left click the mouse, a blue-black line appears which represents the field margin. Drag 
this line to resize the field.

Exporting

Click "Export" to export your shopping list to spreadsheet applications such as Microsoft® Excel™ or text 
editors such as Microsoft® Notepad.™

Printing your Shopping List
Print your Shopping List using the landscape mode of paper orientation. You can choose this mode from the 
Print Setup dialog available under the File menu.

Shell Price
To calculate the costs of building your shell, select a house type from the Price Range. A Bargain Home 
represents the lower end of the price range while a Custom House represents the high end. You can also 
enter your own price in the appropriate box.
The price is then multiplied by the total floor area of your house (shown on the left side), to give you your 
total shell cost on the right side of the dialog box.

4.  Adding, Re-sizing, and Positioning Objects
Visual Home layout involves creating, moving, stretching, rotating, and deleting objects in the workspace. 
Use the status bar in the lower left-hand corner to keep track of width and depth as you re-size objects.

Adding and Deleting an Object
Drawing Walls 



Adding Roofs 
Re-sizing, Rotating, and Positioning an Object

Adding and Deleting an Object
Adding Objects
Step 1: Choose a Category.  
Objects are organized mostly by room types, with a separate category for general layout and miscellany. The
categories are located on the left side of the Object Tool Bar. Click on one of these categories to see its 
menus. If you don't see what you want right away, do a search for your object by clicking on "Find." (See the 
Find Tool).
Step 2: Choose a group from one of the Menus.
Objects are further categorized under menus. To narrow the search for objects on display, select a menu 
item from the drop-down list. For example, you may be interested in only looking at garage doors instead of 
all doors. In the Layout Category, click on the down arrow next to Doors. In the drop-down list, select 
"Garage." The object tool bar will now only display garage doors.

Step 3: Choose an Object.
Once you select an object group, it will appear in the Objects Tool Bar. Notice that when you hold the cursor 
over any object, a descriptive name for that object pops up. 
To place an object, click once on it, then click inside Top View to place the object there. (You can also drag 
the object from the Object Tool Bar to Top View).
After the object is in Top View, move it from one place to another by dragging it. Notice that any changes 
made in Top View apply immediately in 3D View. To see your object in 3D View as you work in Top View, 
adjust the camera so that it points towards your object. As long as the camera is in this position, any 
changes that you continue to make to the object automatically appear in 3D View. 
To pick out colors, materials and styles for your object, see Using Spec Sheets.

Deleting an Object
You can delete an object any time by selecting it and pressing the Delete key, or by selecting Delete from the
Edit Menu. To delete multiple objects, hold the Shift Key while selecting objects, and delete them using one 
of the same methods. To clear off all objects from Top View, select the Delete All command from the Edit 
Menu. 

Tip: You can undo many commands by selecting Undo from the Edit Menu.

Drawing Walls
Using the QuickDesign™ Wizard is the easiest way to build your design since it draws walls around all of 
your rooms automatically.
If you want to add more walls in Top View, first click on "Layout," and then select "Room Elements" from the
Basics drop-down menu. This displays the Wall thumbnail in the Object Tool Bar. Next, click on the wall tool
and move your cursor to Top View. While holding down the mouse, draw the wall length with your cursor. 
Notice that as you are drawing, the length automatically appears in the status bar in the lower left corner of 
the screen. Let go of the mouse to drop the wall into place.
Once you connect walls, the corners snap together and generally stay snapped when you drag adjacent 
walls. Walls and rooms do not stretch together--that is, if you resize a room in Top View, the walls will not 
stretch with it. Similarly, stretching walls to another size will not stretch the room either. This is why we 
recommend that you create all your rooms with the Wizard.
By default, Wall Snap is turned on under the Options Menu. This ensures that the walls join when they are 
drawn close together at corners and T junctions. 
To control the responsiveness of Wall Snap, set the Wall Snap Distance from the Options Menu. By default, 
they snap together when they are within 1 foot of each other.



Adding Roofs
Roofs function differently than all other objects in Visual Home. Once you drop the roof into Top View you will
probably need to reshape it to cover the house.

To add a roof to your home, open the Layout category by clicking on "Layout." Next, click on the Basics tab 
and select roofing from this menu. Click on the roof thumbnail. Then drag the roof outline from any corner to 
cover your house in Top View. To change the shape, grab the circular center handles and stretch them to 
create new corners.

Drag any edge of the roof (but not the handles) to resize it. To create new 
corners, pull the circular handles in or out. The square corner handles move the corners to change angles. 
Note that large black squares appear at adjacent corners to show you when a corner forms a right angle. 
Zoom in if necessary to see the corners better.
To see a brief video that explains a convenient approach to resizing and shaping your roof, open 
Roof.avi from your Program Manager (if you are a Windows® 3.1 user) or from the Books that Work 
sub-menu of your Start menu Programs option(if you have a Windows® 95 machine).
To change the roofing material, double-click on your roof to open its Spec Sheet. Here, you can changes 
materials and the roof pitch. (See Using Spec Sheets on how to make these changes). There are four roof 
slopes available to you under Roof Pitch: flat, shallow, moderate and steep. The program defaults to the 
shallow roof pitch. Choose the one that suits your plan best.

You can also edit roofing materials from The Exterior Inspector. Click on "Exterior" from the Side Tool Bar.

Adding Dormers and Chimneys
You can add dormers and chimneys to your roof based on the roof pitch you select. The dormers are named 
with the slope they fit. For example, "gable dormer for steep roof" fits the steep roof pitch.

To raise or lower the dormer, click once on it to select it, then enter a new Height above floor measurement 
in the dormer's Spec Sheet.
Add chimneytops in the same way as dormers.

Hiding the Finished Roof
To view and edit the rooms covered by your roof, click on "roof" from the Side Tool Bar's View buttons to 
hide it in Top View and 3D View. 

Re-sizing, Rotating, and Positioning Objects
Position an Object
To move an object in Top View, select it, and move your cursor over it until the "Move" handle appears, then 
drag the object where you want it. This moves the object at its present height above the ground.

Height  Each object you drop into Top View "falls" to a given height. It may be the floor, but there are many 
exceptions. Ceiling lights stop at the ceiling. These are controlled by the object's height-above-floor setting. 
To re-position an object's height, double-click on it to open its Spec Sheet. On the left-hand side, you will 
find the current Height Above Floor. Type in a new height and click OK to see the results in the 3D window.

Most smaller objects will stop on large items like beds or tables. To drop them further, like books into a 
bookshelf or a bowl in a cabinet, use the Drop Through command in the Move tools or menu. See the Move 
Menu.

Snap.  In Visual Home, many objects snap into place against walls. Doors, windows, cabinets, wall-hung art 
and mirrors are some obvious examples. If you don't want this to happen, turn of General Snap in the 
Options menu. Walls also snap together, but have somewhat different rules. See Drawing Walls.



Re-sizing an Object

 Click once on an object to select it in Top View. The black boxes that appear 
around the object are Stretch Handles. Hold the cursor over one of these stretch handles until the word 
"Stretch" pops up over the cursor. Click and hold one of the stretch handles. Dragging the mouse in and out 
adjusts the object's width and depth.

To return an object to its original size, open its Spec Sheet. Click on the "Original Size" button on the left side
of the Spec Sheet box. Note that some objects have a list of Suggested Sizes instead. In this case, choose 
any from the list and click OK. 

Rotating an Object

Each select object has a Spin handle on its front. Click and hold the spin handle. Then move the 
mouse in the direction that you want to rotate the object.

5.  Finding the Right Objects for your Design

The Find Tool
Making Custom Objects
Copying Custom Objects
Downloading from the Internet

Find Tool
To locate a specific object or group of objects, click the "Find" button located on the left side of the Object 
Tool Bar. You have the option to enter an object type such as "chair", and choose a specific style and/or 
manufacturer. You must type a complete word to get a matching word. The tool searches on the names of 
the objects and keywords, too.

Making Custom Objects
In some cases, it may be appropriate to create your own objects. Visual Home offers a number of simple, 3-
dimensional shapes you can resize and re-texture. Look under the Extras menu, in the Layout category. 
There you will find triangular, circular, and rectangular objects. Experiment with these shapes, or create new 
ones by stacking them. Copy and retain shapes that you like.

Copying Custom Objects
Copying is the best way to make multiple, custom objects for your design. Once you have chosen a style or 
your own dimensions for an object or room, copy it! Every time you copy and paste an object, its copy will 
retain all of the original's dimensions, colors, and materials. You can also copy rooms and their 
corresponding walls. 
To copy an object, simply select it, and use the Copy and Paste commands under the File Menu. The 
standard keyboard functions work as well.
<CRTL> X = Cut
<CRTL> C = Copy
<CRTL> V = Paste.



Downloading from the Internet 
How to Get New Stuff

The Visual Home web site offers collections of new objects for use in the program as well as new Sample 
Files. To access this web site directly from the program, select "Net Link" from the Features Menu. If you are
hooked up to the Internet, Netscape® opens to the Visual Home web site (http://visualhome.com). Here, click
on "Collections" and choose from a list of our own and manufacturer's object collections to download to your 
hard drive. The web site will carry detailed instructions that will help you with this downloading process. You'll
also find up to date links for the best sites on home design.

If you don't find what you're looking for, please drop us an e-mail at requests@visualhome.com.

To make new stuff, see Making Custom Objects.

6.  Adding Colors and Textures to Your Home
Visual Home allows you to pick colors and textures for your existing rooms and furnishings using Spec 
Sheets. Simply double-click on an object and its Spec Sheet opens, displaying a set of the object's editable 
features.
Rooms have a special type of spec sheet called Room Spec Sheets. Room Spec Sheets are slightly different
from ordinary spec sheets since they allow you to make changes to an entire room and all of its furnishings in
just one place. Room Spec Sheets are a powerful tool and go hand in hand with RoomBlocks™. 
See the topics below on how to style your home using Spec Sheets and Room Spec Sheets.

Using Spec Sheets
Using Room Spec Sheets

Using Spec Sheets
Use Spec Sheets to edit the information on the characteristics of an object, including its size, materials, 
color, style and price. To open an object's Spec Sheet, either double-click on the object, or select it and 
click "Change" in the Side Tool Bar.

Basics
This tab displays the object's name, current dimensions and materials.

Size and Location. 
These controls are the best way to precisely control the size and elevation of the objects. You can 
change the width, depth, height, and height above floor by entering new dimensions in these fields. You 
can always return to the object's original size by clicking on "Original Size" or one of the Suggested 
Sizes.
Once you have decided on your object's dimensions, check "Lock Size." This prevents you from 
accidentally stretching it in Top View. Notice that once you check this box, the Width, Depth, and 
Height fields are no longer editable.
Check "Lock Size & Location" if you also want the object's position to remain the same as well. 
Checking that box will make all the fields under Size and Location unavailable for editing. 

Materials. 
The panels shown under the Materials section represent all the editable colors and textures in your 
object. Some objects may have several panels, some may only have one. Each panel provides a picture
sample of the material as well as the name of the region to which this material is applied. To see the 
name of each material, hold the cursor over the panel to bring up its popup description.
To change a material, click on its panel. The Change Materials box opens. Here, you can choose from 
hundreds of materials for your object. (See Choosing Materials). After you choose a new material, 
click OK to return to the Basic Info tab. The panel will show your change.



Once you are satisfied with your chosen materials, you can check the "Lock Materials" box at the 
bottom of the section to prevent these materials from being changed later. Click again on the box to de-
select this option.

Additional Information
Some objects will have additional information, corresponding to other regions on the object, such as 
counters and handles. This information will appear on the right hand side of the dialog box. Also, if your 
object is a door, you have the option of making it closed or "invisible" so you can look through it when 
you navigate in 3D.

Replace With
To replace your object with something similar, click the "Replace With..." button. See Replace With....

Info and Net Links
These tabs provide information and links to selected web sites about the selected object. 
For Web Users. Below the text window is a list of links to Web Sites that provide supplemental 
information on your object. Highlight a link of your choice. Then click on "Site Review" to read a short 
summary of the Web site. Or click "Connect Now" to go directly to the Web Site. See Downloading 
from the Internet.

Price
If the object has a price, you will find a Price tab, too. Use this tab to review and edit your object's price. 
Visual Home provides Low, Medium and High end prices for your objects, based on competitive, 
installed prices found in the current market. Choose one of these prices, or click "Yours" and type in a 
price of your own. The price you select appears on the Shopping List. See Shopping List.

Replace With 
Each object is associated with a group of related items, so you can replace any object in your design 
with another style or similar item. You'll find these in the "Replace With" window. 
Click on the "Replace With..." button on the right side of the Basics tab. For example, suppose you have
first placed a Country-Style sofa in Top View. But while you are in the sofa Spec Sheet, you decide to 
change the sofa into a Contemporary-Style sofa. You can make this change by scrolling through the 
choices offered in the "Replace With" box and clicking on your new choice. Notice that the popup 
definition of each sofa style appears when you hold your cursor over it. When you are finished, click OK 
to accept the change.

How to Choose Materials
Materials refer to the colors and textures of an object. Visual Home allows you to change the colors and 
textures on not just one object, but on all related objects in a room, at once.

To change an object's materials, double-click on it. To change materials on a set of objects in a room, 
double-click on the room. In either case, the corresponding Spec Sheet opens. Under the Materials 
section, you will see panels for different parts. (For example, a sofa might contain one panel for the 
upholstery, one for the throw pillows, and one for the sofa feet).

Click any of these panels to open the Choose Materials dialog box for that part of the object. Here you 
have the option to look at all materials listed in Visual Home, or only a list of suggested materials 
corresponding to the component you are editing.
Scroll through the Materials window to look at your choices. Notice that if you rest your mouse on any 
material, a popup description of the material opens. Each material type button on the left displays one 
material category, like masonry. Most categories are further subdivided by a pull-down menu in the 
upper right.
When you find a material you want, click it once and click OK.

Some objects use the same material type in separate regions. For example, a sofa uses one fabric for 
both the upholstery and its cushions. In this case, two numbered panels appear under the materials 



section, labeled fabric #1 and fabric #2, or wood #1 and wood #2. The first refers to the body of the 
object, and the second material usually refers to secondary components.

Using Room Spec Sheets
Room Spec Sheets are a special type of Spec Sheet. Use them to globally change materials in a 
RoomBlock™, rather than styling individual walls, floors, and other objects.
All rooms have Room Spec Sheets. To open a room's Spec Sheet, either double-click on the room, or select 
it and click "Change" in the Side Tool Bar.
Click on the tabs at the top of the Room Spec Sheet to switch between different pieces of information.

Basic Info.
This tab lists your room's name and basic materials. If you created your room in the QuickDesign™ Wizard, 
the room name and type will already be entered in the fields. If you created the room in Top View, or if you 
want to change the room's name or its type, enter them in the fields at the top of the dialog box.

Shape 
To change the shape of a room, click on "Change Shape." The "Change Room Shape" dialog box opens, 
displaying a number of room shapes. Pick a room shape by clicking on it and clicking OK. You will be able to 
stretch the room shape once you leave the Room Spec Sheet. 

Basic Materials. 
The panels shown under the Materials section represent the materials used in your room for the walls, 
floors, ceilings, and furnishings, etc. Each panel provides a picture sample of the material as well as the 
name of its corresponding group. To see the name of each material, hold the cursor over the panel to bring 
up its popup description.
To change a material, click on its panel. The Change Materials box opens. Here, you can look through a 
number of materials for your object. (See Choosing Materials). After you choose a new material, click OK 
to return to the Basic Info tab. The panel will reflect your change.

The Various panel appears when you have more than one material used in a given group. For example, if 
some metal fixtures in your kitchen are brass and some are stainless steel, the Various metal panel appears.

Ceilings and Walls
Adjust your ceiling and wall heights using the drop-down menu in each category. The "Make Ceiling Visible" 
check-box controls whether the room's ceiling appears. Uncheck it to make your ceiling invisible. Note that 
ceilings are always transparent when viewed from above.

Info and Net Links
This tab provides text information and Net Links about materials applied to the object. 
For Web Users. Below the text window are a list of links to Web Sites that provide supplemental information 
on your object. Highlight a link of your choice. Then click on "Site Review" to read a short summary of the 
Web site. Or click "Connect Now" to go directly to the Web Site. 

Info and Net Links
This tab provides text information and Net Links on your selected object. 
For Web Users. Below the text window are a list of links to Web Sites that provide supplemental information 
on your object. Highlight a link of your choice. Then click on "Site Review" to read a short summary of the 
Web site. Or click "Connect Now" to go directly to the Web Site. See Downloading from the Internet.

Changing Your Room Shape
To change the shape of a room, select it and click "Change Room Shape." Click on one of the choices, click 
OK, and the new shape will replace your old room. Note: the new shape requires sufficient space to fit 
between the adjacent rooms. If there isn't enough room for the new one, drag the old room to one side and 
try again. You can later stretch your room in Top View.



7.  Menus and Buttons

Visual Home Menus 
Top View Object Tool Bar 
Side Tool Bar 
3D Navigation and Tool Bars 

Visual Home Menus
File Menu
Edit Menu
Options Menu
Features Menu
Move Menu
Windows Menu

File Menu
New
Returns you to the entry screen in Visual Home, where you have the option to create 
a new design, using the QuickDesign™ Wizard, or go straight to the Designer.
Open
Opens an existing Visual Home file.
Open Sample
Opens one of the sample home designs provided by Visual Home.
Save
Saves your current open file.
Save as
Changes the name of the existing file.
Save as Sample
Saves your design in the QuickDesign™ Wizard before you go to the Designer so you
can try multiple versions of a design. You'll find these samples in the Open Sample 
dialog, under "My Samples."
Mail This Design
Allows you to mail your design using a Microsoft® mailing program. If you do not 
have an e-mail package, you should not use this command. It may crash your 
system.
Export Bitmap
Saves your current 3D View as a two-dimensional bitmap image which you can later open in a graphics 
program.
Print
Prints the contents of either Top View or 3D View, depending on which window is 
active. See Optimizing Your Printing.
Print Setup
Use Print Setup to specify printer, paper orientation and type of paper used. Click on the Options button to 
select advanced printing settings. Press F1 in Print Setup for further on-line help.

Exit
Exits the program.



Edit Menu
Undo
Undoes the last command executed in the Designer. 
Cut
Removes a currently selected item from your design and puts it on the clipboard. This command is 
unavailable if there is no item currently selected. Cutting items to the clipboard replaces the contents 
previously stored there.
Copy
Copies a selected item onto the clipboard. This command is unavailable if no item is currently selected. 
Copying an item to the clipboard replaces the contents previously stored there.
Paste
Inserts a copy of the clipboard contents into your design. This command is unavailable if the clipboard is 
empty.
Delete
Deletes a selected object in Top View.
Delete All
Delete all objects in Top View.
Select All
Selects all objects in Top View.
Select None
De-selects all currently selected objects in Top View.
Lock Selected in Place
Locks a selected object in place to prevent it from being moved afterwards.

Options Menu
Sounds
When selected, plays all sounds in the program. When deselected, sounds are turned off.
General Snap
When selected, objects such as doors, windows, cabinets, and wall-hung art will snap into place against 
walls. Deselect to turn this feature off.
Wall Snap
When selected, walls will attach to other walls when they come within a certain distance from one another. 
Deselect to turn this feature off.
Wall Snap Distance
Sets the distance required between two walls in order for them to snap together.
Display Room Labels
When selected, displays the names of each room in your design. Deselect this feature to turn the labels off.
Display Metric Units
Allows you to switch between dimensions in English or Metric units.
Show All on Shopping List
By default, most architectural elements and furnishings added to your design appear on your Shopping List,
including those objects that have no prices. De-select this feature to hide the objects without prices from your
List.
Allow Multiple Files
Allows you have open multiple files at the same time. If this feature is turned off, you will only be able to have
one file open at any time.
Cartoon Color Mode
When selected, converts your 3D View to simpler, "cartoon" colors. While objects carry less details, using 
Cartoon Color greatly improves rendering time.



Features Menu
Net Link
Opens the Netscape® Navigator™ Software program. As a bonus to our customers, Visual Home provides a
free copy that you can install from the Books That Work program group or menu.
View Shopping List
Opens the Shopping List, a feature that keeps track of your selected objects, as well as their quantities, 
installed prices, unit prices, and subtotals. See Shopping List.
Export Shopping List
Click "Export" to export your shopping list to spreadsheet applications such as Microsoft® Excel™ or text 
editors such as Microsoft® Notepad.™ Again, see Shopping List.
Recorder Control
Opens the Recorder Control. Use this feature to record a WalkAbout™ in 3D View. See Recording A 
WalkAbout™.

Move Menu
Use these commands to move a selected object or a set of selected objects in a desired direction. Left, 
Right, Upscreen, and Downscreen represent horizontal and vertical movements on the screen. Drop drops 
an object from the ceiling to the next surface such as a table or countertop. If you want to lower the object all 
the way to the floor, use Drop Through. Similarly, Raise lifts an object from the floor to the next surface. 
Raise Through lifts the object all the way to the ceiling.
You can also use the Move button on the Side Tool bar to carry out the same functions as the Move Menu. 
See the Side Tool Bar. See Tips and Tricks for further information concerning moving objects.
Tip: to select more than one object, hold the Shift key down while you click on objects.

Windows Menu
There are two program displays or windows in the Designer: Top View and 3D View. You can have one or 
both windows open at any time. (The Designer automatically opens both). In general, the smaller your 3D 
window size, the faster your machine's performance.
Select Overlap Windows to overlap your windows one on top of the other.
Select Arrange Side by Side if you want to your windows to appear side by side.
Select Arrange Top to Bottom if you want your windows to appear from top to bottom.
Zoom In
Allows you to view your design from a closer vantage point.
Zoom Out
Allows you to view your design from farther away.
Zoom to Fit Page
Resizes Top View to display all objects.
Top View
Makes the Top View window active. Top View is where you select, place, and modify the elements of your 
design.
3D View
Makes the 3D View window active. 3D View is the three-dimensional viewing mode in Visual Home.

Print
You have the option to print Top View or 3D View. Simply click on the desired window to make it active and 
then select Print from the File Menu. 

Optimizing Your Printing



To improve the quality of the printout, maximize the 3D View window before printing. Try both portrait and 
landscape printouts, as they will yield different results.
The quality and size of your printout are related to your display resolution. The higher your monitor's 
resolution, the better and larger the size of the image on your printout. Printing from a 640-480 resolution will 
yield a print on which the image will be smaller and less clear than printing from a monitor set to a higher 
resolution.
If you need to get a custom size for your printout, or if you want to incorporate the image into another 
document, use the "Export Bitmap..." item in the File menu to save your image as a bitmap. You can bring 
this bitmap into a paint program or word processor to suit your needs.
Print your Shopping List using the landscape paper orientation. You can choose this by using the Print Setup 
item under the File menu.

Print Setup
This command allows you to specify a printer, paper orientation and type of paper used.  Click on the 
Options button to select advanced printing settings. Click on the Help button to receive further on-line help.

Top View Object Tool Bar
Object Tool Bar

When Top View is the active window, the top tool bar offers category buttons and menus. Objects are 
organized mostly by room types, with a separate category for general layout and miscellany. The categories 
are located on the left side of the Object Tool Bar. Objects are further categorized under menus, which 
appear at the top of the Object Tool Bar. Once you find the object you would like to include, simply click on 
its icon and drag it into Top View. Notice that a popup description of each object appears when you hold your
cursor over it.
If you don't see what you want right away, do a search for your object by clicking on "Find." 

See also Adding, Resizing, and Positioning Objects 

Side Tool Bar 
The appearance of the Side Tool Bar changes slightly, depending on your computer's display settings. 
Unless stated otherwise, the graphics below describe the options that appear on the Side Tool Bar of a 640 x
480 pixels display. See Recommended Video Display.

This button provides control over how much detail is displayed in Top and 3D Views. It opens a 
dialog box that turns furniture, roof, decor or rulers on or off. We recommend that you work with the roof 
option Off, except to edit the roof.

This option appears in display settings of 800 x 600 pixels or higher and is merely an extension 
of the View feature described above.



Click "Change" to open the Spec Sheet of a selected object or room. This is the equivalent of 
double-clicking on an object or room.

Click the Zoom tools to reduce, enlarge or size your design to fit the Top View window. In 3D 
View, the left two buttons move you closer to or further from your plan, respectively, and the button on the right 
ceases to function.

Click to access tools that allow you to move your objects within your plan. The same tools are 
available under the Move Menu. Tip: to select more than one object, hold the Shift key down while you click on 
objects.

These buttons appear in a display setting of 800 x 600 or higher. The same tools are available 
under the Move Menu

Click to open the Recorder and take snapshots or record WalkAbouts™ of your 3D scene. See 
Recording a WalkAbout™

Opens the Exterior Inspector, where you set the style of your home's exterior and choose a 
background scene. See the Exterior Inspector. 

Click to open the Shopping List, which gives you a rough cost estimate. This icon appears only
under a display setting of 1024 by 768 pixels.

View Options

Use View Options to control what you see on the screen. Checking any of these elements simply hides them 
from view. You can always turn them back on by clicking again. Turning off some of these features may also 
be a good way to improve drawing speed in 3D View. See Tips and Tricks for other ways to improve 
rendering time.

3D Navigation and Tool Bars
3D Navigation Tool Bar

Click "Move Me" to use your mouse to navigate in 3D View (see 3D View Navigation). Click 
"Edit Stuff" to use your mouse to select objects. 



Click these to view your design from above or at eye level.

Click the Move arrows to step in the direction that you want.

To adjust your viewing height, click on the up and down arrows. The viewing height appears in 
the window next to the up/down arrows.

Use Tilt to control your viewing angle.

3D Options Tool Bar

Use the arrows to adjust the lighting in your 3D scene.

Choosing Your Rendering Quality

These options allow you to trade rendering quality for speed.

Select (1) Full Light, No Materials, (2) Minimal Light, All Materials, or (3) Full Light, All Materials to determine 
the rendering quality of your 3D View. Lower light and number of materials increase drawing speed. Likewise,
using full light and all materials improves the quality of rendering, but slows your machine's performance.

You can also set your scene quality under by selecting "Cartoon Color Mode" under the Options menu, which
is the equivalent of Full Light and No Materials.

Exterior Inspector
Use the Exterior Inspector to set the style of your home's exterior parts and choose a background scene.
Editing Exterior Regions
The panels under the Materials section represent the editable regions of your exterior. Each panel provides 
a picture sample of the material as well as the name of the region to which this material is applied. To see 
the name of each material, hold the cursor over the panel to bring up its popup description. 



To set or change the materials for a region, click on that panel. Scroll through the window to look at your 
choices. Notice that if you rest your mouse on any material, a popup description of the material opens above 
the cursor. Each material type button on the left displays one category and most categories are further 
subdivided by a pull-down menu in the upper right.
When you have found a material you want, click it once and click OK. Your exterior region will now adopt 
your newly chosen material.
Choosing Ground Cover
Click on the ground cover panel to change your ground cover. Since selecting a ground cover is very similar 
to choosing materials for your exterior, follow the same directions above.
Choosing a Background Scene
Choose an outside view from the list in the scrolling window. The scenes range from sunsets to outer space. 
If you want to insert your own bitmap image, click on Choose My Own to select and open another bitmap file.

Change Setting
Choose an outside view from the list in the scrolling window. The scenes range from sunsets to outer space. 
If you want to insert your own bitmap image, click on Choose My Own to select and open another bitmap file.

8.  Dimensions in Visual Home
There are a number of places where you can view and edit the dimensions of objects and rooms in Visual 
Home. 

Rulers
Rulers appear on the left and upper sides of the screen in the QuickDesign™ Wizard and Top View. 
However, they behave differently in each location.

In the Wizard, rulers keep track of the length and width of each individual room as you select and move it. In 
Top View, they display measurements between the ends of parallel walls. The rulers automatically adjust as 
you resize these walls. 

You may turn off the rulers in Top View by clicking on "rulers" on the Side Tool Bar's View button.

Status Bar
The status bar in the lower left corner of the screen displays an object's dimensions as you drag or re-size it. 
This is the best way for you to get an idea of an object's dimensions as you work.  Non-linear objects, 
such as stairs, display dimensions for their area, while linear objects, such as walls, display only their length. 

Spec Sheets
To specify an exact dimension for an object or room, type it directly into its Spec Sheet. Simply double-click 
on the object and on the left side of the Basic Info tab, you will see editable size fields. Here, you can also 
control the object's height above the floor.

Standard Versus Metric Units
To switch between Standard and Metric units, select or de-select "Display Metric Units" in the Options Menu.
If "Display Metric Units" is not selected, Standard units will display automatically.

Glossary

Dragging
Dragging refers to holding down the mouse while you move it across the screen.

WalkAbout™
WalkAbout refers to the navigational feature of 3D View that allows you to take a smooth, 
textured "walk" through your design. See 3D View  and Recording a WalkAbout™.
Snap



In Visual Home, many objects snap into place against walls. Doors, windows, cabinets, 
wall-hung art and mirrors are some examples. If you don't want this to happen, turn off 
General Snap in the Options menu. 
Walls also snap together with each other but have somewhat different rules from General 
Snap. See Drawing Walls for details.

camera
The tool shown in red in Top View that is used to control your view in 3D. Point it towards 
an area that you wish to see in 3D View. Any changes that you make to this area 
automatically appear in 3D View. See Using the Camera.

Designer
The main screen, consisting of Top View, 3D View, the object tool bar, and side tool 
bar.

Top View
The program window in Visual Home where you drop objects from above, arrange and edit
them.

3D View
3D View shows you a realistic representation of your design. The red camera seen in Top 
View controls what you see in 3D. You can also move through your home, using your 
mouse or the arrow keys at the top of the screen. 

Object Tool Bar
The area at the top of the screen that displays objects and furnishings. The Object Tool 
Bar is only available in Top View.

RoomBlock™
Each room created in the QuickDesign™ Wizard includes walls, a floor and a ceiling. 
When you add objects, from rugs to windows to lights, they become part of the 
RoomBlock™. RoomBlocks™ allow you to move the room and its contents. They also let 
you change materials globally for a whole room, rather than styling walls, floors, and other 
objects individually. RoomBlocks™ are made automatically with the QuickDesign™ 
Wizard but can also be added in Top View. 

Rotating

Each selected object has a Spin handle on its front. Click and hold the spin 
handle. Then move the mouse in the direction that you want to rotate the object.

QuickDesign™ Wizard
These four steps help you to build your initial home plan. The Wizard creates 
RoomBlocks™, the basis of all design work in Visual Home. After you finish The Wizard, 
your design will appear in the Designer.

Spec Sheets
Use Spec Sheets to edit the information on the characteristics of an object or room, 
including its size, materials, color, style and price. To access the Spec Sheet of an object 
or room, double-click on it, or select it and click on "Change" from the Side Tool Bar. 
Room Spec Sheets are a special type of Spec Sheet that pertain to rooms and their 
furnishings. See Using Spec Sheets and Using Room Spec Sheets to see how the two 
differ.

Side Tool Bar



The Side Tool Bar refers to the panel of buttons on the left side of the Designer. Use the 
Side Tool Bar to make adjustments to objects, record views and tours in 3D, and view your
Shopping List. See the Side Tool Bar 

Stretching

 Click once on an object to select it in Top View. The black 
boxes that appear around the object are Stretch Handles. Hold the cursor over one of 
these stretch handles until the word "Stretch" pops up over the cursor. Click and hold one 
of the stretch handles. Dragging the mouse in and out adjusts the object's width and depth.
As you drag, the object's current width and depth are displayed in the Status bar at the 
bottom of the screen.

Panels
Panels are the squares listed under the Materials section in Spec Sheets. Panels show a 
small picture of the material assigned to an object or room region. The object or room 
region's name appears on the panels as well. Hold your mouse over the panel to see a 
popup material description above the cursor.

Shopping List
A feature in Visual Home that keeps track of selected objects, as well as their quantities, 
installed prices, unit prices, and subtotals. Each category is shown as a button on the left 
side of the List. Click the button to see a breakdown of price and quantity for each object. 
Clicking the button again hides these details. See Shopping List.

9.  Tips and Tricks

Setting up your 3D view
Position your red camera in Top View before switching to 3D View. This saves navigation time in 3D. Rotate 
the camera by dragging its handle, and position it so that it faces a spot you want to see in 3D View.  
Remember!  You can save views of your design by using the Recorder and Snapshot commands found on 
the Side Tool Bar.

Making your home blend in with your chosen location
Some of the options for the location of your home (find Locations in the Exterior inspector on your Side Tool 
Bar) are designed so that you don't need a ground plan, for the ground is already built into the location.  In 
order to "turn off" your ground plan, or make it invisible, go to the Exterior inspector and click on the "Ground 
Cover" image in order to bring up the material changer.  From the "exteriors" tab, choose the "g) ground 
cover" sub-category.  Scroll down and find the material that says, "None. Use location's ground cover." 

For easier viewing of a single room…
If you find that it is difficult to get a full view of your room, but that stepping back causes you to leave the 
room and look straight into the wall, try moving a wall away!  Simply select the wall, preferably one that has 
nothing attached to it (for example, do not move a wall that has many cabinets attached), and drag it off to an
area that is outside the rest of your floor plan.  The wall will retain its properties.  Now view your room as if it 
were a stage, and get a better feel for the look of the space.  When you are satisfied, simply grab the wall 
and put it back in place.

"Opening" and seeing through doors
Having trouble walking through your house or seeing into a room?  Try opening a door.  Double click on a 
door to bring up its inspector.  On the main, Basic Info page, choose the "invisible" option in the box titled 
"Show Door."  This will replace your door with a doorway until you decide to change it back to your chosen 
door style by choosing the "show door closed" option.

Improving the look of items that hang on a wall



Sometimes, things that hang on walls are difficult to see because they compete with the wall for who gets to 
be viewed.  Try making your picture frame or mirror slightly thicker than it would be in real life, or turn off the 
"General Snap" under the options menu and then position the picture frame slightly away from the wall.

To avoid clutter and make decorating a space easier….
Add decorative elements such as books, picture frames, throw pillows, etc., AFTER you have your major 
furnishing in place.  This will allow you to experiment freely with room arrangements without having to 
reposition every small object.

Placing an object onto or underneath another object
When you first attempt to place an object onto another, it will "fall" nicely onto the object below (unless it is a 
large piece of furnishing; these always go directly to the floor.)  For example, placing books on a table will 
cause the books to adopt a "height above floor" value that is equal to the height of the table.  However, if you
then change the height of the table, the "height above floor" of the books will not change, and you will find 
that your books are now sliced by the table.  Here are three tips for placing objects vertically:
Change the Height Above Floor of an object.  In a single object's inspector, you can change the height 
above floor value of an object so that it "rests" on any other object.  For example,  to correct the scenario 
above in which the books are now inside the plane of the table, change the "height above floor" of your books
to equal the new height – not the height above floor -- of the table.  
Use the Move commands to easily Drop objects to lower surfaces.  The Drop command is ideal for 
placing smaller objects into bookcases.  For example, place books on top of a bookcase.  The books will 
"fall" to the uppermost shelf.  Then hit the Drop arrow and watch the books fall to the next shelf.  Hit the Drop
arrow again to move them to the next lower shelf.  Be aware that Visual Home will drop an object only into 
spaces that are large enough to accommodate the object that is being dropped, so if you find that your books
do not drop, it is because the space between the shelves in your bookcase is too short to fit the height of the 
books.  In cases like this, try adjusting the height of either your books or your bookcase.
Use the Move commands to easily Raise objects and place them under another object.  The Raise 
command is perfect for anything that "hangs" or attaches to the underside of another object, like hanging 
lights to the ceiling, or range hoods that attach to the underside of a wall cabinet.  For example, place a  
range hood under a cabinet.  You will want to initially place it roughly on top of the wall cabinet under which 
you want it to attach.  Then, with the hood still selected, use the drop commands to lower the hood a 
successive number of times until it is resting on top of the surface that is directly below the wall cabinet (this 
surface would, most likely, be a stove or cooktop.) Then, use the Raise command.  The hood will raise to the
next downward-facing surface, which in this case is the bottom of the wall cabinet.   You can also use the 
Raise command to raise lights and hanging plants to the ceiling.  Like the drop command, Visual Home will 
lift an object only into spaces that are large enough to accommodate the object that is being lifted, so if you 
find that your hood does not raise, it is because there is no room to fit the object.
In general, make it a general rule of thumb to get an object to the desired size before placing objects
on top of it.  A good way to do this is to place major furnishings first, perfect them, then add more 
decorative items such as books, flowers, etc., after you have the major elements of your design in place.

Placing an object directly next to another object
Again, use the Move commands to accurately place objects in horizontal space.  Hitting the move up screen, 
move down screen, move left and move right commands from the Move menus will move an object in that 
direction until it hits another object.  Objects in Visual home will not snap to each other (though most will 
snap to walls), but this is a sure-fire way to get a snap effect.  So, if you know you want cabinets to line up, 
place a second cabinet near the first, and then hit the appropriate Move arrow to line them up.  You can also 
use the arrow keys on your keyboard to move a selected object in any of these directions in ½" increments.

Moving objects accurately
To move objects precisely in top view, use the arrow keys on your keyboard.  Arrow keys move an object ½".

Moving objects directly up or directly to the side
Select an object in Top View and move it while holding down the shift key.  This will limit movement to a 
vertical or horizontal direction only, allowing you to be more precise.  Of course, you can also use the arrow 
keys on your keyboard for small, exact movement of an object.

Moving more than one object at a time



While holding down the SHIFT key, select numerous objects. Then click and hold down on one of the 
objects, and move your mouse as you hold down.  All of the selected objects will move.  NOTE: You can 
move all the objects in a room simply by selecting the room and moving it.  Any object in that room, with the 
exception of some walls, will move with the room.

Improving the speed of your walkthrough
You may want to downgrade the quality of your 3D scene if you are simply trying to check the spatial layout, 
and not the materials and color schemes, of your design.  This will speed up your walkthrough and the time 
that it takes for the program to generate your 3D scene.  With the 3D bar selected, choose the Scene 
Options button.  You will notice three choices labeled slowest, medium, and fastest.  Choose medium or 
slowest while working on the layout of your design, then switch to the "slowest but best" option to see your 
3D scene with full color and lighting.

How to make exterior walkways and driveways
Place a floor on the exterior of your house and stretch it into the length and width you desire.  Simply go into 
the inspector and change the material to the cement, brick, or another ground cover.

Making an exposed beam ceiling
Exposed beams are a wonderful detail for any house, rustic or modern.  You can do this easily in Visual 
Home, but you should make this the LAST STEP IN YOUR DESIGN.  Adding beams early in the design 
process means that the beams will obscure objects below and make selecting other objects more difficult.  
Follow these steps:
1)  To place a beam, choose a horizontal beam from the Layout/Extras/Rectangular Shapes toolstrip and 
place it in your Top View.
2)  Position the beam and stretch it to the length, width and height you desire.  Select the beam and use the 
Raise command from the Move menu to lift the beam until it hangs from the ceiling.  
3)  Go into the beam's inspector and give it an appropriate material.
4)  With the beam selected, Choose Copy, then Paste from the Edit menu to create another beam with the 
same attributes as the first.  Continue pasting until you have enough beams to span the room.  Space them 
according to the style you are trying to achieve.

Creating Soffits
Soffits can generally be described as parts of the ceiling that are lower than the rest of the ceiling.  They are 
used around the edge of a room where the wall meets the ceiling.  In kitchens, they are most often used to fill
in the gap between the top of the wall cabinets and the ceiling.  Soffits can also "step" up a ceiling for very 
dramatic effects, or be placed over a sink area or window to highlight that area of a room. You can do this 
easily in Visual Home, but you should make this the LAST STEP IN YOUR DESIGN! Adding soffits early in 
the design process means that they will obscure objects below and make selecting other objects more 
difficult.  To create a soffit, follow these steps:
1)  From the Layout, Extras, Rectangular Shapes strip, choose a horizontal beam and drop it into your Top 
View design.
2)  Position the beam near the wall to which you are adding a soffit, and stretch the beam so that it is the 
same length as the wall.
3)  Give the beam a height, depth and material that you desire.  Notice that you need not give it a height 
above floor value from the inspector, as you will set this using the move tools in the next step.
4)  With the beam selected, use the Move commands to position the beam.  Use whichever horizontal space 
command (move left, right, upscreen, or downscreen) that is needed to push the soffit to the wall.  The use 
the Raise command to raise the beam so that it attaches to the ceiling.  Use this command as many times as
needed to get it into place.
5)  Copy, then Paste this beam.  Rotate it 90 degrees and line it up against a second wall in your room.  
Stretch this second beam as needed so that its width matches that of the second wall.
Repeat step #5 until all the walls in the room have soffits.

Creating Wainscoting
Wainscoting, otherwise know as wood paneling for walls, usually wraps around the lower 1/3 to one half of 
your wall, with the upper part of the wall being painted in a solid color or wallpapered.  Wainscoting is 
particularly well suited for traditional styles; lighter color wood paneling with a light floral wallpaper might be 



the perfect details for an eating nook, while dark paneling gives formal rooms a look of elegance.  Here is a 
recipe for adding wainscoting to a room:
1)  Create a normal wall.  Paint or wallpaper it with the color/pattern that you want for the upper part of your 
wall.
2)  From the Layout, Extras, Rectangular Shapes strip, choose a vertical panel and drop it into your Top 
View design.
3)  Position the panel next to the wall to which you are adding wainscoting, and stretch the panel so that it is 
the same length as the wall.
4)  Give the panel the following dimensions: height = about 36", depth = about 3".
5)  In the panel's inspector, choose a material that suits your taste.
6)  To add a decorative strip of trim to the top of the wainscoting panel, choose either a horizontal beam or 
horizontal trim object from the Layout, Extras, Rectangular Shapes strip.  Line it up with the wall and stretch 
it to the same width. In its inspector, make its height above floor equal to 36", and its depth slightly wider than
the panel below it, or about 5".  Choose a material that suits your taste.

Create a raised area for a room
Often, raising the floor of an eating nook or any other section of your home can create a dramatic effect by 
setting an area off from the rest of the room without the use of walls.  This is rather tricky to do, but in our 
own course of experimentation, we've found a rather easy way. Follow these instructions:
1)  Choose the cube from the Layout, Extras, Rectangular Shapes strip and place it in the area of the room 
that you want to be raised.
2)  In Top View, stretch the cube so that it is the width and depth of the area to be raised.
3)  Go into the cube's inspector and change its height to one that you prefer for the raised area.  If you 
choose a height greater than about 9", you will need to add steps that lead up to the area.  Creating steps is 
described in Step 5 of this tip.
4)  While in the cube's inspector, choose a flooring for the cube.  
5)  Creating Steps:  Simply repeat steps 1-4 above with a second cube, but make this cube have a lower 
height.  Stretch this cube to a width and depth that is appropriate for a step leading to your raised area.  
Create as many steps, all with differing heights, as needed to reach your raised area.
NOTE:  Major furnishings will not drop directly to the surface of the raised area described here.  You will 
have to change the height above floor value of the objects that rest on the raised area to the same as the 
height of the raised area itself.  Any object that you place in this area will have to have a Height Above Floor 
value of the height of the floor PLUS its own height above floor.  For example, a normal wall cabinet would 
have a HAF of 56", while a wall cabinet within a raised area would have an HAF of  63" (54" + 9" for the 
raised area).

Tips for Placing Cabinets
Making wall cabinets extend to the ceiling: From the Room Layout strip, place a wall.  From the 
Cabinetry strip, place a wall cabinet.  Open its Spec Sheet (by double-clicking on the cabinet, if necessary).  
Change the height to 42" (assuming your ceiling has a standard height of 96").  Click <OK> to exit the Spec 
sheet and return to Top View.  Select the wall cabinet and attach it to the wall.  View in 3D!
Use the Copy and Paste commands to duplicate cabinets of the same size and configuration:  If you 
know that all of your, say, upper cabinets will be a unique, non-standard height and all will have mullions, 
place only one upper cabinet and use it as a basis for others.  Go into this cabinet's inspector and make it the
size, material, and style that you desire.  With this cabinet selected, go to the File menu and choose Copy.  
Then go to the File menu again and choose Paste. You will now see a duplicate of the first cabinet.  You can 
repeat the Paste command as many times as you like, so long as you do not copy a new object (the program
will remember only your most recent copied object.)  You can then go into the inspectors of any of the pasted
cabinets and change that cabinet's individual properties.
Making upper cabinets that extend to the ceiling:  All upper cabinets default to a height of 30" and a 
height above floor of 54".  Both numbers are standard, but you may want your cabinets to extend to the 
ceiling.  Open an upper cabinet's inspector and change the height to 42".  Assuming your ceiling has a 
standard height of 8', your cabinet will now reach to the ceiling.  If your ceiling is  higher, add extra inches to 
the cabinet to make it reach.
Creating two layers of upper cabinets:  Two layers of wall cabinets that extend to the ceiling is a 
fashionable look for kitchens -- and a practical storage solution.
1)  Place a row of wall cabinets that have a height above floor of 54" and a height of 24".



2)  Now, copy and paste each of the wall cabinets in this row.  Double click on the copied cabinet to view its 
inspector.  
3)  In the inspector, change the copied cabinet's height to 78" and make its height 18".
4)  Move this copied and resized cabinet so that it is directly on top of its "parent," or the lower wall cabinet 
from which it was initially copied.

Creating a Kitchen Island
To create an island, simply arrange base cabinet units in a pleasing design in the middle of your room.  You 
can increase the width of your island in two ways: by increasing the depth of the base cabinets to more than 
24", though after depths of more than about 30", the cabinet space becomes inaccessible; or, create another 
row of base cabinets that stands back-to-back with the first row.  Experiment with the depths of both rows 
until you are happy with the counter space of your island.

By adjusting the sizes of base cabinets, and using different base cabinet styles such as diagonal and corner 
units, you can come up with some very interesting island formations.  Just remember to leave at least 42" for
circulation between the island and other work areas.

Creating Kitchen Counter Seating
1)  Create your counter area or island as you normally would, with a row of base cabinets, but now, make 
sure that the "Include Counter" option is turned off for all the base cabinets (turn it off by going into a base 
cabinet inspector and unchecking the "Include Counter" box.)
2)  Using the Find key on the Object Tool Bar to search for "wall shelf."
3)  Stretch the shelf so that it hangs over the cabinets by at least 9" on the side where you will have counter 
seating.

Creating a Kitchen Island with Multiple Levels
Simply vary the height of the base cabinets you use in your island!

Creating a Kitchen Island with an Elevated Area for Counter Seating
Sometimes you will want to have part of an island higher than another, perhaps to hide a sink.  This elevated 
area can serve as a fashionable eating area.
1)  Create a row of  base cabinets that is at least 24" deep; this will serve as your workspace. 
2)  Create another row of base cabinets that lines up back-to-back with the first row, where all the base units 
are 40.5" high, 8" deep, and do not have counters (uncheck the "Include Counter box in the base cabinet 
inspectors.)  You can vary the depth of this row of base cabinet units to achieve a comfortable width for your 
island.  You will now have one island unit, with cabinets that open on the front and back.
3)  Find the Counter object and place it in your Top View over this taller row of base cabinets.  Stretch it so it 
is as long as the row of cabinets below.  In its inspector, give it the following dimensions: height above floor =
40.5", height = 1.5", depth = 17" (the depth of the row of cabinets, plus 9" overhang for dining.)  Specify the 
material of the counter.
Place seating stools from the Details strip.  Stools without backs should be 30" high, while stools with backs 
should be 44" high.
*If you only have enough room for a narrow island, but still want an elevated eating counter, you can 
substitute the higher row of base cabinets for a piece of wood onto which the elevated counter will sit.  To 
create support for the counter:
a)  Choose a vertical board from the Layout/extras/Rectangular Shapes toolstrip. Double-click on it to bring 
up its inspector.
b)  Give the board a desired material and the following dimensions:  width = [length of island/eating counter 
area, height = 40.5" and depth = 3".
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Disclaimer and Copyright 

System Requirements
 486DX/66 or higher IBM® PC or compatible

 For Windows® 95: 8 MB RAM Minimum
16 MB recommended

 For Windows® 3.1: 16MB RAM Minimum

 3 MB free hard disk space (20 MB free hard disk space recommended)

 VGA graphics (256 colors)

 CD-ROM drive

 Sound Card Recommended

In general, the more physical memory (RAM) you have the better Visual Home will perform. There is a big 
difference between 8Megs, 16Megs, and 32Megs. Windows® 95 uses memory more efficiently than 
Windows® 3.1.

The faster the CPU you have, the faster your program will run, especially in 3D View. Clock doubled chips 
won't improve performance as much as a chip with a faster clock rate. For example a clock doubled 50 MHz 
runs externally at 25 MHz and may be slower than a 33 MHz CPU.

System Behaving Strangely?
With its many advanced features, Visual Home will require more memory than some computers can provide. 
If your hardware runs short of memory, you may notice one or more of these symptoms:

 - Parts of the application do not start or display.
 - The display shows an inappropriate color scheme.
 - Print-outs appear as if created on a typewriter.
 - The computer stops responding to keyboard or mouse commands.

If you encounter such difficulties, several techniques can help you overcome memory shortfalls:

 - Close other applications while running Visual Home. Please note that some programs may start 
automatically when you launch Windows. You'll find these in your Windows Startup group.
 - Under Windows® 3.1, increase the size of your virtual memory. You can control this from the Windows 
Control Panel in 386 Enhanced Mode.
 - Reboot your computer.
 - Increase the amount of random access memory in your system. 

Recommended Video Display
For best results, you'll want to use at least an 8-bit video card capable of displaying 256 colors. While the 
program will work fine at 640x480, we recommend at least 800x600, and there are benefits to 1024x768, as 
well.

Sound
Visual Home includes music, narration and sound effects. To hear these, you'll need a Windows-compatible 
sound card. If you don't hear sound as you enter Windows, then you don't have Windows sound.

Disclaimer and Copyright

State and local building codes and practices may vary. Some of the practices demonstrated in this software 
may not be permitted by your local building department. You are responsible for complying with such codes 
and practices, including obtaining the required building permits. Construction materials, tools, skills, and site 



conditions also vary, and you assume all risks relating to such matters. You should always obey local and 
state laws, obtain required permits, follow manufacturers' instructions in operating tools, and observe safe 
work practices. IN NO EVENT SHALL BOOKS THAT WORK BE LIABLE FOR (1) ANY CLAIM OF INJURY 
TO PERSONS OR PROPERTY OR DEATH RESULTING FROM THE USE OF THIS SOFTWARE OR ANY
STRUCTURES BUILT OR REPAIRS PERFORMED IN CONNECTION WITH SUCH USE, OR (2) ANY 
DAMAGES OR OTHER RELIEF ARISING OUT OF THE USE OF THIS SOFTWARE, INCLUDING 
WITHOUT LIMITATION ANY INDIRECT, CONSEQUENTIAL OR INCIDENTAL DAMAGES OR LOST 
PROFITS, EVEN IF BOOKS THAT WORK HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES OR CLAIM. SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, THEREFORE THE LIMITATIONS SET FORTH ABOVE 
MAY NOT APPLY TO YOU.

Books That Work and the Books That Work logo are the trademarks of Books That Work. Windows and the Windows logo are trademarks 
of Microsoft Corporation. Portions of this software are Copyright 1993-95 Criterion Software Ltd. and its Licensors. Netsape Navigator and 
the Netsape Navigator Included logo are trademarks of Netscape Communications. Other brand and product names are trademarks or 
registered trademarks of their respective organizations.
© Copyright 1996, Books That Work. 2595 E. Bayshore Road, Palo Alto, CA 94303. All rights reserved.

Technical Support
For technical support with this software, please call (415) 843-4440 or send e-mail to support@btw.com. 
For information on Books That Work products, call (800) 242-4546 or browse our Web site at 
http://www.visualhome.com.
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